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Technical Support
For technical support and questions about CDProW, contact the author directly:

For fastest response, send E-mail to:

bukovics@mindspring.com

Or, send via mail to:

Bruce Bukovics
CDProW Support
P. O. Box 2192
Alpharetta, Georgia 30023-2192
U.S.A.

Once you have registered your copy of CDProW, you may wish to visit our web site in order to get the 
latest copy of CDProW.    Our URL is:

http://bukovics.home.mindspring.com



Release History
All of the enhancements to CDProW were a direct result of your suggestions so keep those suggestions 
coming!

Release 2.1 contained the following enhancements and corrections. 

1. Added CD Player access.    This allows you to retrieve total CD time, number of tracks, 
and individual track times automatically from the CD.    There is no longer any need to 
manually type in this information.

2. Corrected a problem with the custom report definition and import definition.    The problem
arose when you tried to open an existing definition but selected Cancel without selecting 
a file.    This caused the program to crash.    

Release 2.0 contained the following enhancements and corrections. 

1. Ported the application from 16-bit Windows to full 32-bit Windows 95 or Windows NT 
format.    

Release 1.7 contains the following enhancements and corrections.    

1. Corrected subscript out of range error when the number of tracks field receives focus.    
Error only occurred when starting with an empty file.    Workaround was to start with one 
of the demo files and delete all entries.

2. Corrected several problems with fields not being correctly painted.

Release 1.6 contained the following enhancements and corrections.

1. Added a new sort sequence:    label and catalog number.
2. Searches may now be performed using any combination of text, medium and category at 

the same time.

Release 1.5 contained the following enhancements and corrections.

1. Corrected a bug:    If you open a second file without exiting, the artist list will merge with 
the first file. 

2. Eliminated the search menu and moved it under the Edit menu.
3. Overall use of cleaner fonts and design.    Bold and 3D attributes were minimized in order 

to present an overall better appearance.
4. The main list window has been redesigned.
5. Increased the Title field from 40 to 80 bytes.
6. Increased the Artist field from 40 to 80 bytes.
7. Increased the Description from 40 to 80 bytes.
8. Increase the Track titles to 80 bytes.
9. Provided new search fields:    label; catalog number; release year; track description.
10. Modified the design of the search screen to be more user friendly.
11. Added new drop down lists for label field.
12. Now allows the entry of individual times and descriptions for each track.    Track times are 

entered in minutes and seconds.
13. Allows entry of total recording time in minutes and seconds.
14. A new option is provided to automatically update the total time based on the individual 

track times.
15. Added a new custom print field "Track Titles/Times" that prints both the track title and 

time.
16. Enhanced import/export to handle new total time format of min/sec.    Also added the 



ability to import and export track times along with track titles.
17. Added a tape calculator function that allows the selection of individual tracks from 

multiple CDs.    
18. Added new standard tape calculator report.
19. Added the ability to copy the tape calculator report to the Windows clipboard.    This 

allows you to paste this into any format that you want using the standard Windows paste 
function.

20. General clean up of the online help.

Release 1.4.1 History 
Release 1.4.0 History 
Release 1.3.0 History 
Other Release History 



Release 1.4.1 History
1. Corrected a screen redrawing problem with the entry and additional entry screens.



Release 1.4.0 History
1. Corrected a problem with the number of tracks being zeroed out when you add a new 

record.    This forced reentry of this number before you could enter track titles.
2. Made the default category list optional.    By turning off default categories, the category list

will be built from the list of categories that are actually in use within your file.
3. Added a new search type (Text / Begin) which will only match the start of a field.    Useful 

if you want to only print a section of your file.
4. Added 3 new sort sequences.    1) Artist / Release Year, 2) Category / Title, 3) Category / 

Artist.    These are in addition to 4) Title and 5) Artist / Title that were already supported.
5. The registration number is now shown in the about box.
6. The program now starts quicker if you have registered - the initial delay in the about box 

is shorter.
7. The size of track titles has been increased from 40 to 60 positions.
8. Added an option to automatically open the last file loaded when you start the program.
9. Removed the "Are you sure?" confirmation from the program exit.



Release 1.3.0 History
1. Added Import and Export capabilities.
2. Added right mouse support for popup menus
3. Changed Release Date to Release Year.    This field now only accepts a year value.
4. Added the ability to print track titles on custom reports
5. Added Open/Save buttons on the report designer window
6. Moved the Number of Discs, Number of Tracks and Total Time fields to the main 

Recording Entry window.    Moved the misc key fields to the Additional Info window.
7. Added a View Previous button to the Recording Entry window.
8. Corrected problems with international date formats
9. Improved overall display performance
10. Create help file using 3.1 help compiler.    Version 3.1 of help is now required to view 

online help.



Other Release History
1.2.5 Corrected numerous printing problems 
1.2.4 Performance Enhancements for handling large data files
1.2.3 Correct miscellaneous problems
1.2.2 Correct miscellaneous problems
1.2.1 Enhancements to search functions
1.2.0 New version with major enhancements
1.1.1 Correct miscellaneous problems
1.1.0 Enhancements to editing and printing functions
1.0.1 Correct miscellaneous problems
1.0.0 First version



Registration
CDProW is a shareware package.    Shareware is not free.    If, after an initial trial period not to exceed 30 
days, you find the software useful and continue to use it, you must pay a license fee for the right to use it. 
During the 30 day trial period you are under no obligation to buy it.    

The license registration fee for CDProW is U.S. $25.00.    

It is possible that our address or registration instructions have changed since you obtained this copy of 
CDProW.    For this reason, we suggest that you visit our web site to verify that you have the latest version
as well as our current registration address.    Our URL is:

http://bukovics.home.mindspring.com

Once your register your copy of CDProW, you are entitled to download and use any new releases of the 
software.    While copies of CDProW may be obtained in many different places, you can always rely on 
our web site to have the latest release.

To register, send:

1. Your name and address
2. Internet E-mail address if available (or major online service such as Compuserve, AOL, etc.)
3. The location where you downloaded CDProW.    This is the internet URL address, BBS name and 

phone number, major online service forum, etc.    This information helps us to update known sites with
the latest version. If you obtained CDProW from our Web site, please tell us how you found out about 
the site.

4. U.S. $ 25.00 (check or money order payable in U.S. Dollars only!) 
5. Checks should be payable to:    Bruce Bukovics

To:
Bruce Bukovics
P. O. Box 2192
Alpharetta, Georgia 30023-2192
U.S.A.

Once you have registered, you will receive a registration number which must be entered using the 
Options / Register menu selection.    This registration number unlocks the software so that you have 
unlimited use beyond the 30 day trial period.    The fastest way to receive your registration number is to 
provide an internet E-mail address or an address for one of the major online services (Compuserve, AOL, 
etc).    If you provide this address, we will E-mail you the registration number and you can immediately 
begin using CDProW beyond the trial period.

As a shareware program, you are permitted to distribute it, provided that you do not charge for it and that 
all files are distributed together along with all copyright information.    This program is provided as is 
without any warranty, expressed or implied.



How To
How To Add Entries
How To Change An Entry
How To Delete An Entry
How To View Additional Information
How To Work with Titles
How To Work with the Tape Calculator 

How To Register CDProW



Working With Reports
The Reports option from the main menu allows you to design, load and save custom report definitions.    A
custom report is one that you design.    You select the number and order of the columns that will be 
printed.    Any number of different custom report definitions can be saved and recalled whenever you need
to use them.

Follow these steps to use a custom report:

1.    To use an existing report, select Open from the Reports menu.
2.    To design a new report, select Report Designer from the Reports menu.
3.    Select Save or Save As from the Reports menu to save it.
4.    Select Print from the File menu to print your custom report.



Open Report Definition
This option is used to load an existing custom report definition.    You would need to do this whenever you 
want to print or change a custom report.    

After selecting this option, you are presented with a dialog box where you can change the drive and 
directory to search for the report definition you wish to load.    



Save Report Definition
This option is used to save a custom report definition after you have designed a new report or changed an
existing one.    Selecting Save Report Definition saves the definition under the current name.    Selecting 
Save As Report Definition presents you with a dialog box which allows you to change the drive, directory 
and file name to be saved.



Report Designer
The report designer allows you to define your own custom reports.    Each report definition can be saved 
to a different file name and used whenever it is needed.    

Designing a custom report is as simple as selecting fields to print from a list of available fields.    The fields
are then printed on the report in the order they are selected by you.    If you make a mistake, you can 
delete fields that you have selected.    Each column has a default width based on the size of the field 
selected.    You can optionally change the width of each column.

The following fields are used during the report design process:

Report Heading
Available Columns
Selected Columns
Add Button
Delete Button
Open Def Button
Save Def Button
Change Column Width Area

After designing a report, select the Save Def button to save your custom report definition.    Use the Close 
button to return to the primary recording list.    You can then proceed directly to the Print option from the 
File menu to print your custom report.

The Clear button is used to clear all entries in the selected list and to start designing a new report.



Report Heading
Use this field to enter a heading for your report.    This heading will be saved with the report definition.



Available Columns
This list displays all fields that are available for printing on a custom report.    The field name and default 
column width is listed for each field.    

To place a field on the report, select the field and press the Add button or just double click on the field 
name.



Selected Columns
This list displays all fields that you have included on the report.    Next to each field name is the column 
width that will be used for the column.    This width may be the default column width or it may have been 
changed by you using the Change Column Width area.

The fields are listed in the order that they will be printed on the report.    If you wish to delete a field, select
the field name and then press the Delete button.



Add Button
Press this button after selecting a field from the Available Columns list to add it to the report.    This has 
the same affect as double clicking on the Available columns list.



Delete Button
Use this button to delete a column from the report.    First select a field from the Selected Columns list, 
then press this button.



Change Column Width Area
This area is used to change the default column width of a field on the report.    To use, follow these steps.

1.    Select the field to change from the Selected Columns list.
2.    Change the Column Width field to the new width
3.    Press the Adjust Width button to save the change



Save Def Button
Use this button to save a new or changed report definition.    This button performs the same function as 
Save from the main Report menu.



Open Def Button
Use this button to load an existing report definition.    Any unsaved report definition that you have created 
will be replaced.    This button performs the same function as Open from the main Report menu.



Printing
Printing of reports involves the following steps:

1.    Perform Printer Setup
2.    Design or load a custom report
3.    Use Search to limit the contents of the report
4.    Start Printing



Printer Setup
Select the Printer Setup option from the File menu to setup the printer.    This must be done prior to any 
printing.

The Heading and Detail fonts should each be selected using this window.    To change a font, select the 
Set Heading or Set Detail buttons.    These buttons will display a dialog window that allows you to select a 
font along with font size and other settings.    

After making changes, select Close to return to the primary window.

The printer settings only affect the current session.    If you exit the program without saving the 
configuration from the options menu, then these settings will be lost.    



Print
The Print option from the File menu initiates printing of reports.    There are 3 kinds of reports available:

1. A standard report
2. Tape Calculator Report
3. Custom reports

The standard report is always available and is a simple list of recordings in the current file.    Custom 
reports must first be designed and loaded using the Report designer.    The Tape Calculator report is only 
used to produce list of all tracks selected by the Tape Calculator function.    Custom reports allow you to 
select any number of columns for a report in any order.

The sequence of entries listed on a report is determined by the sort order.    

To print a report:

1.    Select the type of report (standard, tape calculator or custom)
2.    Load a custom report using the Report Designer if necessary
3.    Change the report heading if desired
4.    Select Setup if necessary to setup printer fonts
5.    Select the Entries to print (all or search results)
6.    Select Print to start printing



Loading and Saving Files
Starting A New File
Opening A File
Saving A File



Starting A New File
Selecting New from the File menu clears the current set of recordings and starts a new file.    After 
entering recording information, make sure you select Save As from the File menu in order to save your 
changes as a named file.

See Also

Opening A File
Saving A File



Opening A File
Select Open from the File menu in order to locate and load an existing file of recordings.    A dialog box is 
presented that allows you to change the drive and directory in order to locate the file you wish to load.    

If you have set the Load Last File option from the Options menu, then the last file that you loaded will 
automatically be loaded again the next time you start CDProW.

See Also

Starting A New File
Saving A File



Saving A File
Select Save from the File menu in order to save all changes to an existing file.    If you have not previously
saved the file, then your only option is Save As from the File menu.    Selecting this option presents a 
dialog box which allows you to change the drive and directory and to give your file a name.    

See Also

Starting A New File
Opening A File



Searching for Entries
There are 2 methods available to search for specific recordings:    

1.    Use the Locate Button from the Recording Entry / Maintenance window
2.    Use the Search window

The Locate button locates a recording based on the title you have entered.    It matches the title you enter 
to the titles of all other recordings, stopping at the first recording found that matches.

The Search window allows much greater flexibility in searching for specific words, categories, etc.    Also, 
the Search window provides the ability to find multiple recordings while the Locate button method only 
finds a single recording.    

The Search window is also used to limit the number of recordings that will be printed on a report.



Search Window
This window is used to initiate a search of all recordings.    You may wish to do this when you are looking 
for a particular recording, want to see a list of all recordings for an artist, see a list of all recordings that 
are of a particular category, etc.    

The results of this window affect the primary recording list.    You may choose to see all recordings listed 
or just the results of a search.    Report printing may also be affected by the search results.    You have the 
option to print all recordings or just the results of a search.

Follow these steps to initiate a search:

1.    Select the Search Type
2.    Select the Search Location
3.    Enter the Search Value
4.    Select the Search Button to start the search

When a search is completed, this window will be removed and you will be presented with the primary 
recording list which will display the results of the search.



Search Type
The search type determines the kind of search that will be performed.    You have the following options 
which may be used in any combination:

1.    Text Search / Global
2.    Text Search / Begin
3.    Category Search
4.    Medium Search

If more than one search type is selected at the same time, it acts as an AND condition.    This means that 
the recording must match ALL of the selected search options in order for it to be shown.    

A Text Search allows you to search individual fields within all recordings for a text string that you enter.    If
you select Text Search, then you must also enter a Search Location.

Text Search Global looks for the search value anywhere within the selected locations.    Text Search Begin
will only look for the search value in the first position of each field (except for track titles which are always 
searched in all positions).

A Category Search allows you to view all recordings that have a given category.    You must select the 
category from the pull down category list for this type of search.

A Medium Search allows you to view all recordings that are on a given medium.    You must select one of 
the mediums from the option box.



Search Location
The search location identifies the fields that will be inspected during the search.    Any number of fields 
may be selected for the search.    The Set All button is a convenient way to set all fields on.

Select Case Sensitive Search if you want the case of the search string to matter.    If this is not selected, 
the case does not matter.    This means that a search string of 'abc' will match a recording of 'abc', 'ABC', 
'Abc', etc.    

At least one search location must be selected for a Text Search.    Search location has no affect on a 
Category or Medium search.



Search Value
This is the value that you want to find.    Some type of search value is always required.    The actual value 
entered depends on the Search Type.

1.    Text Search - Enter the value you want to find in the Text To Find field.
2.    Category Search - Select the category you want to find from the pull down list.
3.    Medium Search - Select the medium you want to find from the listed options.



Search Button
Press this button to initiate the search.    All other search parameters must be selected before starting the 
search.



How To Add Entries
All new recordings are added from the Recording Entry / Maintenance window.    To get there, select Edit 
from the main menu, then select Recording Entry / Maintenance.    

Most entries on this window are optional.    The only required fields are Title and Artist.    When adding a 
new recording the combination of Title and Artist must be unique.    If you already have a recording with 
the exact same title and artist, you will be warned and given the choice to cancel the add operation or to 
add another entry anyway.

Once the recording has been added you can select the Addl' Info or Titles buttons to enter additional 
information.

See Also

How To Change Entries
How To Delete Entries
How To View Additional Information
How To Work With Titles



How To Change An Entry
Changes to recordings are made from the Recording Entry / Maintenance window.    To get there, select 
Edit from the main menu, then select Recording Entry / Maintenance.    

Before making any changes you must first locate the recording you wish to change.    You do this by 
selecting a recording from the primary list or by moving through the recordings one at a time.    You can 
also select a recording using the Locate button or menu selection.    After making the desired changes, 
select the Save button or menu selection to apply the changes.    If you leave this window without saving 
your changes first, all changes will be lost.

From this window, you can optionally select Addl' Info or Titles to make changes to other information or 
track titles.

See Also

How To Add Entries
How To Delete Entries
How To View Additional Information
How To Work With Titles



How To Delete An Entry
All recordings are deleted from the Recording Entry / Maintenance window.    To get there, select Edit from
the main menu, then select Recording Entry / Maintenance.    

Before deleting a recording you must first locate the recording you wish to delete.    You do this by 
selecting a recording from the primary list or by moving through the recordings one at a time.    You can 
also select a recording using the Locate button or menu selection.    Select the Deletebutton or menu 
selection to delete the recording.    You will be prompted to confirm the delete.

See Also

How To Add Entries
How To Change Entries
How To View Additional Information
How To Work With Titles



How to View Additional Information
The Additional Information window contains additional fields for a recording.    To get there, select the Addl
Info button or menu selection from the Recording Entry / Maintenance window or select Additional 
Information from the main menu after selecting a recording from the list.

See Also

How To Add Entries
How To Delete Entries
How To Change Entries
How To Work With Titles



How To Work With Titles
The Titles window contains a list of track titles for a recording.    To get there, select the Titles button or 
menu selection from the Recording Entry / Maintenance window or select Titles from the main menu after 
selecting a recording from the list.

Before working with titles, it is necessary to set the number of tracks for a recording.    This is done from 
the Recording Entry / Maintenance window.    From this window, set the Number Of Tracks field to the 
number of tracks on the recording.    

Track numbers for multi-disc sets continue from one disc to another.    For example:    If you have a 2 disc 
set that contains 10 tracks on the 1st disc and 7 tracks on the 2nd, you would use tracks 1 - 10 for the 1st 
disc and tracks 11 - 17 for the 2nd.    Or, if you prefer, you can enter each disc of the set as a separate 
item within CDProW and number the tracks starting at 1 for each disc.

See Also

How To Add Entries
How To Delete Entries
How To Change Entries
How To View Additional Information



Recording Entry / Maintenance
This window is used to add, change, delete and view recordings.    The following fields are available:

Title Artist
Description Medium
Label Catalog Number
Release Year Number of Discs
Number of Tracks Total Playing Time
Category Comments
Collection Number Collection Location

Using this window you can perform the following actions on a recording:

Clear Locate
Previous Next
Add Save
Delete Additional Information
Titles Close Window
Read CD Info 

Clicking the right mouse button on this window will bring up the Edit menu.



Title
The title of the recording is entered here.    When adding a new recording, this is one of the required 
fields.    



Artist
The artist name is entered here.    When adding a new recording, this is one of the required fields that 
must be entered.    As recordings are added, a list of all artists is created.    The artist field contains a pull 
down list of all other artists that have been used.    You can use this list to make sure your artist names are
consistent.



Description
This is a one line description of the recording.



Medium
This describes the medium used to store the recording.    The possible choices are:

1.    Compact Disc
2.    Cassette
3.    LP Album
4.    DAT
5.    Other



Label
This field stores the recording label that publishes the recording, such as Capitol, RCA, Epic, etc.    It is 
important to store this information for insurance purposes.



Catalog Number
The catalog number is a unique identifier used by the recording company to identify this recording.    It can
usually be found on the back or edge of a recording or somewhere within the liner notes.    It is important 
to store this information for insurance purposes.



Release Year
This is the year that the recording was originally released.



Misc Keys
This is a set of three key fields that can be used to identify and group recordings.    They can be used for 
any purpose.



Category
The category describes the type of recording, such as Classical, Rock, Country, etc.    There are several 
standard categories that are already setup but you can add as many other categories as you need.    

By entering a new category in the field, it is then added to this list of available categories and is available 
to be used for other recordings.

If you do not want to use the default categories, you can turn them off using the Default Categories option
from the Options menu.    After you turn this option off, the next time you start CDProW and load your file, 
only the categories that you are actually using will be loaded.



Comments
This is a large area where you can enter additional comments about a recording.



Collection Number
This field can be used to store your own unique number for this recording within your collection.    This is 
useful if you already have some numbering system for all of your recordings.



Collection Location
This field can be used to identify the location of the recording within your collection.    If you have some 
numbering system for a very large collection, you may want to keep track of the location by shelf number, 
row, etc.



Clear
This button or menu selection clears the current window and allows you to enter new information.



Locate
This button or menu selection locates a recording based on the title you have entered.    It matches the 
title you enter to the titles of all other recordings, stopping at the first recording found that matches.



Next
This button or menu selection will display the next recording.    The recording displayed depends on the 
sort order selected.    If sorting by title, then the next title in alphabetical sequence is displayed.    If sorting 
by artist, then the next recording in artist sequence is displayed.



Previous
This button or menu selection will display the pervious recording.    The recording displayed depends on 
the sort order selected.    If sorting by title, then the previous title in alphabetical sequence is displayed.    If
sorting by artist, then the previous recording in artist sequence is displayed.



Add
This button or menu selection adds a new recording.    The only required fields are Title and Artist.    When
adding a new recording the combination of Title and Artist must be unique.    If you already have a 
recording with the exact same title and artist, you will be warned and given the choice to cancel the add 
operation or to add another entry anyway.

Once the recording has been added you can select the Addl' Info or Titles buttons to enter additional 
information.



Save
This button or menu selection will store any changes you have made to a recording.    If you do not select 
this after making changes to a recording, any changes will be lost.



Delete
This button or menu selection will delete the recording that is displayed.    You will be asked to confirm the 
delete request before the recording is actually deleted.



Close
This button or menu selection will close the current window.    If you have made any changes to a 
recording and have not selected Save or Add, then your changes will be lost.



Additional Information / Maintenance
This window is used to view or change additional information for a recording.    The following fields are 
available:

Composer
Conductor
Purchase Date
Purchase Price
Sound Rating
Performance Rating
Awards
Misc Keys

After making any changes, select Save to keep the changes or Cancel to ignore any changes that you 
made. 



Composer
This field stores the composer's name for a classical recording.



Conductor
This field stores the conductor's name for a classical recording.



Purchase Date
This is the date that the recording was purchased.



Purchase Price
This is the original purchase price of the recording.



Number of Discs
This field stores the total number of discs or tapes for the recording.    The scroll bar adjacent to the field 
can be used to change the value in the field.



Number of Tracks
This field stores the total number of tracks on the recording.    The scroll bar adjacent to the field can be 
used to change the value in the field.    

You can also update this field with values directly from the CD using the Read CD Info button.



Total Playing Time
This field stores the total playing time for the recording in minutes and seconds.    The scroll bar adjacent 
to the field can be used to change the value in the field.    If entered manually, the time must be entered as
mm:ss including the colon.

You can also update this field with values directly from the CD using the Read CD Info button.



Sound Rating
This field can be used to track a sound quality rating for the recording.    The scale is 0 to 10.    The scroll 
bar adjacent to the field can be used to change the value.



Performance Rating
This field can be used to track a performance quality rating for the recording.    The scale is 0 to 10.    The 
scroll bar adjacent to the field can be used to change the value.



Awards
This large field is used to enter any awards that the recording might have received.



Save
Selecting this button will save any changes made to the recording.



Cancel
Selecting this button will remove any changes that you have made to the recording.



Track Titles
This window is used to view and change the track titles for a recording.    The total number of tracks 
available to change are controlled by the Number Of Tracks field on the Recording Entry / Maintenance 
window.    Before working with titles, it is necessary to first set the Number Of Tracks to a value greater 
than zero.

Track numbers for multi-disc sets continue from one disc to another.    For example:    If you have a 2 disc 
set that contains 10 tracks on the 1st disc and 7 tracks on the 2nd, you would use tracks 1 - 10 for the 1st 
disc and tracks 11 - 17 for the 2nd.

In addition to the track titles, you can also enter the playing time and a description for each track.    

You can either manually enter track information or automatically retrieve the track times from an inserted 
CD.    To automatically update track times, press the Read CD Info button.    This will scan your CD and 
will load the playing times for each track.

To manually enter or change a track, perform the following steps:

1.    Select the track to change from this List Of Tracks.
2.    Change or enter the title name in the Track Title field.    You may optionally enter a track time and 

description at this point.
3.    Select the Save Entry button to update the track list.
4.    Select Save to keep all changes.

If you wish to discard your changes, select Cancel.



Track List
This list contains one entry for each track title.    Select an item from the list in order to change or add an 
entry.



Track Title
This field contains the currently selected track title.    Use this field to make any changes or to enter a new 
track title.



Save Entry
After making changes to a track title, select this button to update the list with the changes.    This step 
must be done otherwise your changes will not be kept.



Save
Once all changes have been made to the track titles, select this button to save all changes.    



Cancel
If you wish to discard all changes made to track titles for this recording, select this button.    



Options
The options menu allows you to perform the following functions:

1.    Select the Sort Options.
2.    To immediately sort the file.
3.    To Save the current settings to a configuration file.
4.    To automatically load the last file the next time you start CDProW.
5. To load or not load the default categories.
6. To automatically calculate the total time field based on individual track times. 



Sort Options
This dialog box allows you to change the current sort options.    The following options are changed:

1.    Sort Mode
2.    Sort Sequence

The Sort Mode can be automatic or manual.    If automatic is selected, then the file is always kept in the 
proper sequence as determined the by Sort Sequence.    If manual is selected, then you must use the Sort
Now menu item to sort the file whenever you wish.

The Sort Sequence can be:

1.    Title - sorted in sequence based on the recording title
2.    Artist / Title - sorted by artist, then by title within artist
3.    Artist / Year - sorted by artist, then by release year of the recording
4.    Category / Title - sorted by category, then by title within category
5.    Category / Artist - sorted by category, then by artist within category
6.    Label / Catalog Number - sorted by label, then by catalog number



Sort Now
Select this menu item to manually sort the file of recordings whenever you wish.    You must use this 
option to sort the file if a manual sort mode was selected on the Sort Options window.



Load Last File
If you select this option, the last file that you loaded will automatically be loaded the next time you start 
CDProW.    Uncheck this option if you want to manually load your recording files after starting CDProW.



Default Categories
If this option is checked, a set of default categories are loaded each time you start CDProW.    If you do 
not want these default categories, uncheck this option.    

The next time you start CDProW, no default categories will be loaded.    Then when you load a recording 
file, a new category list will be built using only the actual categories that are used by your recordings.



Config Save
Select Automatic Config Save to save any configuration changes every time you exit the program.    
Turning this option off requires that you select the Save Config Now option whenever you wish to save the
current configuration.    

The following items are saved as part of the current configuration:

1.    Sort Mode
2.    Sort Sequence
3.    Heading Font
4.    Detail Font
5.    Save Config Settings
6.    Load Last File Settings
7. Default Category Settings
8. Auto Calculate Total Time Settings



Viewing The Recording List
The recording list is the primary window for viewing recordings.    It allows you to easily view a list of all of 
your recordings or to view the results of a search.    The recordings are listed in sequence by Artist or by 
Title depending on the Sort Option settings.

The Filter box allows you to select which recordings to view - either all recordings or the results of a 
search.

You can view more information for a recording by selecting it from the list and then selecting one of the 
options from the Edit menu.    Optionally, after selecting an item from the list, you can click once with the 
right mouse button to bring up the edit menu.    

Clicking the right mouse button while positioned on the body of the window will bring up the File menu.

The available menu choices from this window are:

File Menu - Opening and Saving file, Printing Files, Exiting the program.
Edit Menu - Going to different edit windows to view or change recording information.
Reports Menu - Designs, Loads and Saves custom report definitions.
Options Menu - Define Sort options and save options to a configuration file.
Help Menu - Initiates help functions.



Importing and Exporting
Importing and exporting data is started by selecting Import/Export from the main File menu.    You are then
presented with the File Import and Export window that allows you to define your import or export file, 
select the file to import or export and then to start the import or export process.

The steps necessary to import data are:

Design your import file
Create your import file
Select the import action
Define your import file
Select the import file
Start the import process
Review import errors

The steps necessary to export data are:

Design your export file
Select the export action
Define your export file
Select the export file name
Start the export process

See also

Example Import Files



Designing your Import or Export file
Import and export files are comma delimited files.    This means that each field that you want to import or 
export is separated with a comma.    Optionally, you can change the character that separates each field 
from a comma to any other character you choose using the Delimiter field.    Each import record must end 
in a carriage return and line feed character.

Each field that is considered a "string" field must be surrounded by the String Delimiter character.    This 
character is normally a double quote ("). 

Track titles have special treatment.    They are considered a single string field, so you must surround the 
group of all track titles with the string delimiter character.    Within the track string field, you must separate 
each track with the Track Delimiter field which is normally the semi colon (;).    This track delimiter is used 
to determine where each track title ends.    When importing track titles, it is not necessary to also specify 
the Nbr Of Tracks field.    This field will be calculated based on the actual number of track titles imported.

If you select the Track Titles field, only the actual track titles will be imported or exported.    If you select 
the Track Titles/Times field, then the titles along with the track times will be processed.    Like the Track 
titles described above, the Track Times are actually processed as a separate string field that must 
immediately follow the Track Titles string field.    It is not possible to import or export the track times 
without also processing the track titles.    The track times string field uses the same Track Delimited field 
described above.    

Each field that is imported must be of the correct type and must contain a correct value.    This means that
if a field is a number (such as the Purchase Price field), then you can only import a numeric value into this
field.    If a field is defined as a date (such as Purchase Date), then you can only import a date value.

The Medium field must be one of the following single character codes:
C Compact Disc
T Cassette
R LP Album
D DAT
O Other

When importing data, you only have to specifiy the fields that you want to import.    For example:    If you 
do not want to import Composer or Conductor, then you do not need to define those fields in the Import 
definition.    When the records are imported, those fields that you do not specify will be left blank.    There 
are, however, 2 required fields: Artist and Title.    When importing, both of these fields must be defined.

One of the best ways to see the format that you must use for importing data is to export the demo file that 
is supplied with CDProW.    Simply select all fields to be exported and then review the export file with a file
editor.

Example Import Files



Import / Export Example Files
Example 1:

Fields imported:
Artist
Title
Release Year
Nbr of Discs

"Artist one","Title one",1994,3
"Artist two","Title two",1994,1

Example 2:

Fields imported:
Artist
Title
Purchase Date
Purchase Cost
Track Titles

"Artist one","Title one",03/01/1994,16.95,"Track one;Track two;Track three;"
"Artist two","Title two",12/31/93,17,"Track one;Track two;Track three;"
"Artist three","Title three",,,"Track one;Track two;Track three;Track four;"

In Example 2, track titles are shown with the track delimiter field between each track.    Also, the 3rd 
record does not contain the Purchase Date and Purchase Cost fields.    Note that commas are left as 
place holders for these fields.



Creating your Import file
An import file must be created as an ASCII, comma delimited file prior to import.    For small files, the 
Windows Notepad will allow you to edit a file.    Larger files will likely require a more robust file editor.

Many applications (such as database and spreadsheet applications) allow you to export data in comma 
delimited file format.    If you currently have your recording collection in one of these applications, it should
be a simple task to export the data in the proper format.

See also

Designing your Import or Export file



File Import and Export
This window controls all import and export processing.    It allows you to define the fields that you will 
import or export, select the file to import or export, and to start the import or export process.    As the 
import or export is in progress, a message area on the window shows you the progress of the import or 
export and lists import errors.

Exports are affected by the Filter box on the main recording list.    If All Entries is selected, then all records
will be exported.    If Search Results is selected, then only the records resulting from a search will be 
exported.

The following fields and buttons are available on this window:

File Name Select File Button
Count Action
Available Fields Selected Fields
Add Button Delete Button
Clear Button Delimiter
String Delimiter Track Delimiter
Close Button Start Import/Export Button
Open Def Button Save Def Button
Message Area



Import / Export File Name
This is the currently selected name of the file to import from or export to.    If this is an export, then this file 
will be replaced with the current export data when the export is started.



Import / Export Select File
Use this button to select the import or export file name.



Import / Export Count
This field shows a running total of the records that are being imported or exported.



Import / Export Action
Select Import if you want to load new data into CDProW.    Select Export if you want to extract existing 
CDProW data into a comma delimited file.



Import / Export Available Fields
This list displays all fields that are available to be imported or exported.    The field name is listed for each 
field.    

To select a field for import or export, select the field and press the Add button or just double click on the 
field name.



Import / Export Selected Fields
This list displays all fields that you have selected to be imported or exported.    The fields are listed in the 
order that they will appear in the export file or that they will be expected in the import file.    If you wish to 
delete a field, select the field name and then press the Delete button.



Import / Export Add Button
Press this button after selecting a field from the Available Fields list to include it in the import or export file.
This has the same affect as double clicking on the Available fields list.



Import / Export Delete Button
Use this button to delete a selected field from the import or export file definition.    First select a field from 
the Selected Fields list, then press this button.



Import / Export Clear Button
Use this button to clear the current import or export file definition.



Import / Export Delimiter
This field contains the delimiter that will be expected between all fields in the import or export file.    
Normally, this field defaults to "," (comma) but you can change it to any character.

See also

Designing your Import or Export file



Import / Export String Delimiter
This field contains the delimiter that is expected to be surrounding all "string" type fields.    String fields are
any non-numeric field (such as Title, Artist, etc.).    Normally, this field defaults to " (double quotes) but you
can change it to any character.

See also

Designing your Import or Export file



Import / Export Track Delimiter
This field contains the delimiter that will be used to separate all track titles.    Track titles are imported and 
exported as a single string field.    Within this string field, individual tracks are separated by the character 
specified here.    Normally, this field defaults to ";" (semi-colon) but you can change it to any character.

Since track titles are treated as a single string field, you must surround the track title field with the String 
Delimiter.

If also processing Track Times, they are delimited by this same character and are processed as a single 
string field that immediately follows the Track Titles.

See also

Designing your Import or Export file



Import / Export Close Button
This button is used to close the File Import and Export window.    During the actual import or export 
processing, this Close button is changed to a Cancel button.    Pressing this button during the import or 
export causes the current process to be cancelled.



Import / Export Start Button
This button is used to start the import or export process.    Prior to pressing this button, you must have 
performed the steps outlined in the Importing and Exporting section.



Import / Export Open Definition Button
This button is used to open and load an Import/Export file definition that was previously saved.



Import / Export Save Definition Button
This button is used to save an Import/Export file definition.



Import / Export Message Area
This message area will display errors and warnings during the import or export process.    During the 
import, records are added if possible even if they have errors or warnings.



How To Work with the Tape Calculator
The Tape Calculator can be described as a scratch pad that allows you to organize your tracks in 
preparation for recording.    You can include tracks from any number of recordings within a calculator 
session and can freely move selected tracks from one tape side to the other.    

Once you have organized your tracks, you can print them using a build in standard report.    If you want 
your output in some other form, you can copy the tracks to the Windows clipboard and paste them into 
your word processor or spreadsheet using a convenient push button.    

Follow these steps to work with the tape calculator:

1. Select a recording from the main recording list window.    You can only enter the tape calculator if the 
recording has track information entered.

2. Once you select a recording, either right click and select the Calculator option or use the toolbar.
3. Once on the Tape Calculator window, select the tracks that you want to include.
4. Repeat this process for all recording that you wish to include in the same calculator session.
5. When finished, either print the calculator report or copy and paste the information to another program.



Track Time
This is the playing time for a track in minutes and seconds.    The format of the time must be mm:ss 
including the colon.



Track Description
This is a free form description field for an individual track.    You may want to use this field to list the artists 
associated with the track or other information.



Calculate Total Time Option
When this option is set, the Total Track Time field will automatically be calculated based on the individual 
track times.    When not set, you must manually enter the Total Track time.    



Tape Calculator
The Tape Calculator is used as a scratch pad that helps you organize your tracks in preparation for a 
recording session.    This window has the following features:

1. Allows you to set the total tape time.    As you make changes, the total time used and total time left for 
each tape side is shown.

2. Allows you to combine entries from multiple recordings.    Until you use the Clear function, all of your 
work is saved from one recording to another.

3. One you have completed your work, you can print a standard report or can copy and paste the 
information to a word processor or spreadsheet for printing.    This allows you to print many kinds of 
labels and other forms.

This window contains the following fields:

Artist Name Title 
Total Minutes Available Tracks 
Selected Side Lists 

The following buttons are available:

Current Side Add Track 
Delete Track Swap Sides 
Copy All Clear 
Print ClipBoard 
Close 



Artist
Displays the artist name for this recording.



Title
Displays the title of this recording.



Total Minutes
Use this field to enter the total number of whole minutes allowed on this tape.    This number will be 
divided by 2 in order to calculate the time for each side of the tape.    

If you change this number after you have already selected tracks, the used and remaining time will be 
recalculated.



Available Tracks
This list shows all tracks from the current recording.    The track times are also shown for each track.    

Select an item from this list by double-clicking an entry or by using the >>Add button.    The track will be 
added to the side that was currently selected.    



Selected Side Lists
These lists show the tracks that have been selected for each side (one or two).    In addition to the track 
names and times, a running total of Total Time and Remaining Time for each side is shown.    



Current Side
Use this to select which side is currently active.    For example:    If you want to add entries to side 2, you 
must set this field prior to actually selecting a track. 



Add Track
Pressing this button will cause the currently selected track to be added to the current side.



Delete Track
Pressing this button will cause the currently selected track (from side 1 or side 2) to be deleted from the 
list.



Swap Sides
Pressing this button causes the currently selected track (from side 1 or 2) to be moved to the opposite 
side.    

A shortcut for this function is to simply double-click on a selected track.    



Copy All
Pressing this button causes all available tracks to be copied to the current side.    This is a quick way to 
start with all available tracks and then to delete and swap individual entries.



Clear
Pressing this clears all selected entries.    Do this only after you are completely finished with your current 
work.



Print
Press this button to print all of the selected tracks using a standard formatted report.



ClipBoard
Pressing this causes all selected entries to be copied to the Windows clipboard.    Once there, you may 
use the standard Paste function to place them into another Windows program (word processor or 
spreadsheet).



Close
This closes the window and returns you to the main recording list.    It does not delete your selected 
entries.    Do this when you want to select another recording and continue to add more entries to your 
current work.



Read CD Info
Pressing this button will cause CDProW to read information directly from a CD.    Before you press this, 
you should make sure that you have inserted an audio CD into your computer's CD player.

The information retrieved is:

1)    Total number of Tracks
2)    Total playing time




